Workspace tour

Welcome to Corel DESIGNER®, a comprehensive vector-based package for technical graphic users and technical
illustrators.

This tutorial will help you become familiar with the terminology and workspace of Corel DESIGNER.

What you will learn

In this tutorial, you will learn to do the following:
* understand Corel DESIGNER terminology and concepts
* navigate the application window

* identify workspace tools

Understanding the terminology

Before you get started with Corel DESIGNER, make sure that you understand the following terms.

Term Description

Object Element in a drawing, such as an image, a shape, a line, text, a curve, or a symbol

Drawing Document created in Corel DESIGNER, such as a technical illustration, wiring diagram, or chart

Bitmap Image composed of grids of pixels or dots

Vector graphic Image generated from mathematical descriptions that determine the position, length, and direction of the lines
drawn

Docker Window with controls that are relevant to a specific group of tools or tasks

Flyout Button that opens a group of related tools or commands in the toolbox

Artistic text Text to which you can apply special effects, such as perspective or drop shadows

Paragraph text Text that flows in a text frame and can be edited in large blocks. You can wrap paragraph text around an object,

around artistic text, or around a paragraph text frame. You can also apply formatting options to paragraph text.

Projected drawing Drawing profile that lets you project objects onto drawing planes and create the illusion of three dimensions
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Using the application window

When you start Corel DESIGNER, a drawing window appears in the application window. The rectangle in the center of the
drawing window is the drawing page, where you create your drawing. Although more than one drawing window can

appear at the same time, you can apply commands to the active drawing window only. The Corel DESIGNER application
window is illustrated below.

Corel DESIGNER X7 (64-Bit) - C:\Users\admin|
ile Edit View Loyout Object Effects

©® @

op\OffShoreWindTurbfne des
Bitmaps Text Iabk Teols

& On

Window  Help

(= s FEEY v fnapTo v £ (OB W @
o, 0.5 cm
o, 0.5 cm

Object Manager 5

Brs v )11 v

@ 00lem |3

Page 1 3

JIB < < 1of2 gr M [ Pagel

Page 2 <

—| 2 ¥ ig
v B ] Page 1
* @ #M Guides

= #Hll Annotation
@y # Ml Detail&3D
= M Mask v
@ = # Wl lllustration
8 (] Page 2
* @ #W Guides
i #Hl Layer1
B (] Master Page
Edld |
Ll ld |
S @ @0 Do

Annotation

B 1[0 53

>oha 2 2

& [l como Y0 K100 0.200 mm

Circled numbers correspond to the numbers in the following table, which describes the main components of the application

window.
Part Description
1. Toolbox Floating bar with tools for creating, filling, and modifying objects in the drawing
2. Title bar Area that displays the title of an open drawing
3. Menu bar Area containing drop-down menu options
4. Toolbar Detachable bar that contains shortcuts to commands

5. Drawing window

Area that is outside the drawing page and bordered by the scroll bars and application controls

6. Property bar Detachable bar with commands that relate to the active tool or object. For example, when the Text
tool is active, the text property bar displays commands for creating and editing text.
7. Docker Window with controls that are relevant to a specific group of tools or tasks
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Part

Description

8. Rulers

Horizontal and vertical borders that are used to determine the size and position of objects in a
drawing

9. Document palette

A color palette that helps you keep track of the colors that you use in your document and stores
them for future use

10. Document navigator

Area in the lower-left portion of the application window that contains controls for moving between
pages and for adding pages

11. Drawing page

Rectangular area in the drawing window that represents the printable portion of the work area.

12. Status bar

An area at the bottom of the application window that contains information about object properties,
such as type, size, color, fill, and resolution. The status bar also shows the current cursor position.

13. Navigator

A button at the lower-right corner that lets you access controls for moving around a drawing

14. Color palette

Dockable bar that contains color swatches

|dentifying workspace tools

Application commands are accessible through the menu bar, toolbars, property bar, dockers, and toolbox. The property
bar and dockers provide access to commands that correspond to the active tool or current task. The property bar, dockers,
toolbars, and toolbox can be opened, closed, and moved around your screen at any time.

Toolbars

Toolbars consist of buttons that are shortcuts to menu commands. The standard toolbar, which appears by default,
consists of commonly used commands. The following table explains the buttons on the standard toolbar.

Click this button

To

=

Start a new drawing

@]

Open a drawing

&)

Save a drawing

It

Print a drawing

%]

Cut selected objects and copy them to the Clipboard

Copy selected objects to place on the Clipboard
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Click this button To

Paste the Clipboard contents into a drawing

Undo an action

Redo an action that was undone

Import an element into the current drawing

Export a drawing to another file format

Display the Connect docker and search for content such as clipart, photos, and fonts

Start other Corel applications

Open the Welcome screen

0% < Set or enter a zoom level
o -

IEEEEEEHE

Select an object snapping mode

g— Open the Options dialog box

Draw on a flat plane, such as the top, front or right plane

Draw onto a projected plane bounded by the x and y axes

@ Draw onto a projected plane bounded by the x and z axes

Draw onto a projected plane bounded by the y and z axes

@

Choose a preset for working in projected drawing modes
| Isometric (30, 90, 30) - P ginproj 9
Open the Projected axes docker to create and edit drawing profiles
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Corel DESIGNER also has toolbars for specific kinds of tasks. For example, the Text toolbar contains commands that are
associated with the Text tool. If you use a toolbar frequently, you can display it in the workspace at all times.

The following table describes toolbars other than the standard toolbar.

Toolbar Description

Zoom toolbar Contains controls for zooming in and out of the drawing page. Lets you specify a percentage of the
original view, click the Zoom tool, or select a page view.

Text toolbar Contains controls for formatting and aligning text

Layout toolbar Contains commands related to the layout of your document, including PowerClip frames, text frames,
columns, and alignment guides

Transform toolbar Contains controls for skewing, rotating, and mirroring objects

Print merge toolbar Contains controls for creating, loading, and editing print merge fields, and performing a print merge
Macros toolbar Contains controls for editing, testing, and running macros

Internet toolbar Contains controls for creating rollovers and publishing to the Internet

Drawing plane toolbar Contains controls for choosing a drawing plane and a drawing profile and lets you access the Projected

axes docker. This toolbar is displayed by default.

Parallel drawing toolbar Contains commands for drawing parallel curves

Property bar

The property bar displays controls that are associated with the active tool or current task. Unlike a toolbar, the property
bar has content that changes, depending on what you doing within the application. For example, when you click the Text
tool in the toolbox, the property bar displays only text-related controls. In the following example, the property bar displays
text formatting, alignment, and editing tools.
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Dockers

Dockers resemble the palettes found in other graphics programs, and they display the same types of controls that are
found in a dialog box, such as command buttons, options, and list boxes. Unlike most dialog boxes, dockers can be kept
open while you work on a drawing, so you can readily access the controls you need as you experiment with different
effects. To access a docker, click the Window menu, and click a docker name.

Unlike most dialog
boxes, you can keep
dockers open while
working on a document,
50 you can readily access
the commands to
experiment with
different effects.

An example is the
Property manager
docker. When this docker
is open, you can click an
object in the drawing
window and view
formatting, dimensions,
and other properties of
the object.
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You can attach (or dock) a docker to either side of the application window, or you can float (or undock) a docker and move
it around as you work. You can also collapse dockers to save screen space.

If you open several dockers, they usually appear nested, with only one docker fully displayed.

docker hidden from view by clicking the docker tab.
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Left: Docked and nested dockers. Right: Floating docker. To dock a floating docker, click the title bar, and drag until the
pointer is at the edge of the drawing window. To close a docker, click the X button at the upper-right corner. To collapse
or expand a docker, click the arrow button at the upper-right corner.
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Status bar

The status bar displays information about selected objects, such as color profile, color proofing status, fill type, outline,
cursor position, and relevant commands.

» Polygon with 5 Sides on Layer 1 @ <] Mone & M <:0 roovio K
Sbject Details
- Information Sbout Selected Tool

Color palette

A color palette is a collection of color swatches. You can choose fill and outline colors by using the default color palette,
which contains 99 colors from the CMYK color model. The selected fill and outline colors appear in the color swatches on
the status bar.

The following table describes how to choose a color from the default color palette.

To Do the following

Choose a fill color for a selected object Click a color swatch.

Choose an outline color for a selected object Right-click a color swatch.

Choose from various shades of a single color Click and hold a color swatch to display neighboring colors, and
click a color.

View more colors on the default color palette Click the flyout on the color palette.

Add a 10-percent tint to the color of a selected filled object Click a color swatch while holding down Ctrl.

Toolbox

The toolbox contains tools for drawing and editing images. Some of the tools are visible by default, while others are
grouped in flyouts. Flyouts open to display a set of related Corel DESIGNER tools. A small flyout arrow in the lower-right
corner of a toolbox button indicates a flyout. You can access the tools in a flyout by clicking the flyout arrow. After you
open a flyout, you can easily scan the contents of other flyouts by hovering over any of the toolbox buttons which have
flyout arrows. Flyouts function like toolbars when you drag them away from the toolbox. This lets you view all the related
tools while you work.

[
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In the default workspace, clicking the flyout arrow on the Shape tool opens the Shape edit flyout.

Some tools in the toolbox are not visible by default. You can choose which tools to display in the toolbox.
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To toggle between displaying and hiding the toolbox, click Window » Toolbars » Toolbox.

To hide or display tools in the toolbox, click the Quick customize button [@], and enable or disable the corresponding

check boxes.

Locating tools in the toolbox

The following illustration shows the other flyouts in the default Corel DESIGNER toolbox and can help you locate tools

more easily.
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" 2-Point Line Shift+L
& Multi-Point Line Shift+M
*.. Freehand Shift+F
"o, Bézier Shift+B
né-"u B-Spline Shift+M
58 3-Point Curve Shift+U
Q Pen

/N Smart Drawing Shift+G

Linear Pattern Brush

U
& Linear Pattern Sprayer
B4 Linear Pattern Preset
& Calligraphic
£7  Pressure
] Rectangle  Shift+R
._T 3-Point Rectangle
] Graph Paper D
« 1-legCallout  Shift+A

¥~ 2-Leg Callout
¥l 3-leg Callout

Straight-Line Connector
Right-Angle Connector
Rounded Right-Angle Connector
B-Spline Connector

Bézier Curve Connector

Edit Anchor

Thread tool
Well tool
Cylinder tool
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Prism tool

Basic Shapes
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Polygon Shift+P
Star

Complex Star

Center-Point Circle  Shift+C
Center-Radius Circle  Shift+0
3-Point Circle

Ellipse Shift+E

3-Point Ellipse

Parallel Dimension

Harizontal or Vertical Dimension
Angular Dimension

Segment Dimension

Radial Dimension

Diametric Dimension

Extrude

Blend

Transparency  Shift+|
Envelope

Drop Shadow
Contour

Distort

Virtual Segment Delete  Shift+V
Eraser X
Knife (Premium)

Knife Shift+K

Crop

Interactive Fill
Smart Fill
Mesh Fill

Color Eyedropper
Attributes Eyedropper

Shift+D

For example, if you click the Curve tools button in the upper area, you see its associated tools in the options area. If you
click the 2-point line tool in the options area, it becomes the active tool, and its icon appears on the Curve tools button in

the upper area.
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You can use flyout menus instead of the options area. Click Tools » Options, click Toolbox in the Workspace list of
categories, and enable Display tool groups as flyout menus.

The following table describes the tools in the Corel DESIGNER toolbox.

Pick tools

The Pick tool lets you select, size, skew, and rotate objects.

The Freehand pick tool lets you select objects by using a freehand selection marquee.

Shape tools
k.
-
A&
The Shape tool lets you edit a curve object or text character by manipulating nodes. " @
The Free transform tool lets you transform an object by using the Free rotation, Free angle +
] reflection, Free scale, and Free skew controls on the property bar.
— \:\:‘:‘\
- o )
¢/|  The Smudge tool lets you distort a vector object by dragging along its outline. l-.'-. ‘
H !
Q\-lt-_- \.\ ~
Ny, =,

The Roughen tool lets you distort the edge of a vector object by dragging along its outline.
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The Smear tool lets you shape an object by pulling extensions or making indents along its
outline.

@/ The Twirl tool lets you create swirl effects by dragging along the edge of objects.

The Attract tool lets you shape objects by attracting nodes to the cursor.

The Repel tool lets you shape objects by pushing nodes away from the cursor.

L

Curve tools

The 2-point line tool lets you draw a straight two-point line segment.

The Multi-point line tool lets you draw lines and curves one segment at a time, in preview
mode.

The Freehand tool lets you draw single line segments and curves.

37

The Bézier tool lets you draw curves one segment at a time.
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The B-spline tool lets you draw curved lines by setting control points that shape the curve
without breaking it into segments.

The 3-point curve tool lets you draw a curve by defining the starting point, endpoint, and
6% center point.
i

E The Pen tool lets you draw curves in segments, and preview each segment as you draw.

The Smart drawing tool converts your freehand strokes to basic shapes and smoothed 0 . . .
curves. O .

Linear pattern tools

The Linear pattern brush tool lets you apply brush strokes to a curve and create sweep a \\/) \'*\
7 .

arrows and similar objects.

The Linear pattern sprayer tool lets you draw chains, hoses, pipes, and similar
L

objects. ' AN

The Linear pattern preset tool lets you draw curves by using preset strokes.

The Calligraphic tool lets you draw lines that vary in thickness according to the direction of
S the line and the angle of the pen nib. /
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The Pressure tool lets you draw lines that vary in thickness according to the pressure of the f‘\)

pen nib. x

Rectangle tools

The Rectangle tool lets you draw a rectangle by dragging diagonally.

The 3-point rectangle tool lets you draw rectangles at an angle.

The Graph paper tool lets you draw a grid to simulate graph paper.

Center-point polygon tools

@ The Polygon tool lets you draw a polygon by dragging from the center to a point (vertex) on Q
the polygon. 'O

The Star tool lets you draw perfect stars.

The Complex star tool lets you draw complex stars that have intersecting sides.
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Circle tools

The Center-point circle tool lets you draw a circle by specifying the center point and a point
on the circumference.

The Center-radius circle tool lets you draw a circle by specifying a value for the radius and
then clicking where you want the center to be.

The 3-point circle tool lets you draw a circle by specifying three points on the
circumference.

Ellipse tools

The Ellipse tool lets you draw an ellipse by dragging diagonally.

The 3-point ellipse tool lets you draw ellipses at an angle.

Dimension tools

The Parallel dimension tool lets you draw slanted dimension lines.

The Horizontal or vertical dimension tool lets you draw horizontal or vertical dimension lines.
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D The Angular dimension tool lets you draw angular dimension lines.

The Segment dimension tool lets you display the distance between end nodes in single or
i multiple segments.

The Radial dimension tool lets you display the radius of a circle or circular arc.

@ The Diametric dimension tool lets you display the diameter of a circle or a circular arc.

Callout tools

A 8
. . . [
The 1-leg callout tool lets you draw a callout with one leading line. ﬁ ) | 0oy
|
"4
LIJ u E'\Sigiltla Purus
A 8
. . . [
The 2-leg callout tool lets you draw a callout with a two-segment leading line. ﬁ ) | @
&) iy
T -
\—Sigiﬂla Purus
A 8
The 3-leg callout tool lets you draw a callout with a three-segment leading line. E‘l E & 0 _:_./'I
| |
LIJ u Q Sagittis Purus
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Connector tools

E The Straight-line connector tool lets you draw a straight connector line.

The Right-angle connector tool lets you draw a right-angle connector line.

The Rounded right-angle connector tool lets you draw a right-angle connector line with [:] [:] [:]

curved corners.

The B-spline connector tool lets you draw a curved connector line by using control points.

The Bézier curve connector tool lets you draw a curved connector line one segment at a
: time.

The Edit anchor tool lets you modify connector line anchor points.

Projected shape tools

The Thread tool lets you draw threaded shapes in projected view.
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The Well tool lets you draw threaded well shapes in projected view.

The Cylinder tool lets you draw cylinders in projected view.

The Prism tool lets you draw prism shapes in projected view.

Table tool

The Table tool lets you draw and edit tables.

Perfect Shapes™ tools

The Basic shapes tool lets you choose from a full set of shapes, including a hexagram, a

smiley, and a right-angle triangle.
=L
'

The Arrow shapes tool lets you draw arrows while choosing the shape, direction, and ’7 e
number of heads. These controls are available on the property bar. - e

The Flowchart shapes tool lets you draw flowchart symbols. These controls are available on
the property bar.
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x| The Miscellaneous shapes tool lets you draw ribbon objects and explosion shapes. These
controls are available on the property bar.

@ The Callout shapes tool lets you draw callouts and labels. These controls are available on the
property bar.

Text tool

The Text tool lets you add text, create a paragraph text frame and type within it, or type text
LA} along a path if a curve is selected.

Interactive tools

The Extrude tool lets you apply 3D effects to objects to create the illusion of depth.

The Blend tool lets you transform one object into another through a series of intermediate
shapes and colors.

The Transparency tool lets you apply a transparency to an object to partially reveal image
areas underneath.

=

The Envelope tool lets you distort the shape of an object by applying an envelope to it and
1ol dragging the nodes of the envelope.
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The Drop shadow tool lets you create the illusion of lighting in a two-dimensional drawing
by adding a shadow to an object. You can adjust properties such as feathering, opacity,
edge style, and color.

The Contour tool lets you create a series of concentric shapes that radiate into or out of an
object.

The Distort tool lets you transform objects by applying Push and Pull, Zipper, or Twister
effects.

Deletion tools

The Virtual segment delete tool lets you delete portions of objects between intersecting
lines.

The Eraser tool lets you remove unwanted areas in a drawing.

The Knife (Premium) tool lets you split vector objects, text, and bitmaps along straight,

freehand, or Bézier lines. To use this tool, you must have Premium membership and sign in.

The Knife tool lets you slice an object into two separate objects.

The Crop tool lets you remove the areas outside a selection.
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Interactive fill tools

The Fountain fill tool lets you fill an object with a gradient of colors or shades.

The Smart fill tool lets you create objects from enclosed areas and then apply a fill to those
objects.

The Mesh fill tool lets you fill an object by blending multiple colors or shades arranged over
a mesh grid.

Eyedropper tools

The Color eyedropper tool lets you sample a color from an object in the drawing window or
on the desktop and apply it to other objects.

The Attributes eyedropper tool lets you copy object properties, such as line thickness, size,
and effects, from an object in the drawing window and apply them to other objects.

Zoom tool

™y
The Zoom tool lets you change the magnification level in the drawing window.

Pan tool

The Pan tool lets you drag hidden areas of a drawing into view without changing the zoom
level.
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From here ...

You can explore Corel DESIGNER on your own, or you can learn more by completing other tutorials.

For more information about the topics and tools discussed in this tutorial, refer to the Help. To access Corel DESIGNER
Help, click Help » Product help.

Copyright © 2015 Corel Corporation. All rights reserved. All trademarks or registered trademarks are the property of their
respective owners.
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